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Many language teachers sometimes wish they had a music video at their disposal to get 

students' attention and motivate them. There are so many songs and music videos that 

teachers would like to use in their classes but cannot because of a possibly offensive word or 

an image that is inappropriate for their students. In this workshop, you will learn how to 

create your own music videos and how to edit audio and video songs to fit your needs and 

also upload them onto TeacherTube or YouTube. Participants in the workshop will also be 

invited to be a part of the session entitled "YouTube, ITube, WeAllTube: Using 

TeacherTube or YouTube in the Foreign Language Classroom" to share their impressions, 

ideas and reflections on the videos they have created in the workshop. 

Dr. Mohamed Esa 

McDaniel College 

Department of Foreign Languages 

Westminster, MD 21157 

E-mail: mesa@mcdaniel.edu 

http://www2.mcdaniel.edu/german 
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Equipment needed 
 

• Digital camera or camcorder 

• Computer 

• Microphone (built in or remote microphone) 

• Audio music CD 

 

Software needed 
  

• Film editing software:  

o Pinnacle Studio Version 9 and higher (not free) 

o Windows Movie Maker: Standard with Windows XP/ Vista 

o iMOVIE: Standard with all MacBook, iMACs, G4 and G5 MACs 

• GoldWave version 5.1. or higher This is a shareware. The software can 

be downloaded from http://www.goldwave.com *) 

• Audacity 1.2.5 or higher is a digital audio editor available free of 

charge at the audacity website: http://audacity.sourceforge.net **) 

• Lame MP3 encoder to convert any audio files into MP3 format is 

available from the lame website at: http://lame.sourceforge.net/download.php 

• Sound effects (available on the Internet or part of video editing software)  

• A search engine in the target language, i.e. www.google.de or www.google.fr  

 

Other Film Making Software:  

 

Pinnacle Studio 12: http://www.pinnaclesys.com ($49.99 and up) [PC] 

PowerDirector by Cyberlink: http://www.cyberlink.com ($69.95 and up)  

Ulead VideoStudio X2: http://www.ulead.com ($79.95 and up) [PC] 

Roxio Creator 2009: http://www.roxio.com/enu/products/creator/suite/overview.html $79.95 [PC] 

Final Cut Studio 2: http://www.apple.com/finalcutstudio/finalcutpro/ ($1,299 or $499 (for an 

upgrade from Final Cut Studio) (MAC) 

Final Cut Express 4 (a smaller version of Final Cut Pro) ($199 or $69 for an upgrade)  

______________________ 
 

*) “GoldWave is a professional digital audio editor. It is one of the most popular and highest rated audio 

editors for Windows. Use it to play, edit, mix, restore, and analyze audio, or apply special effects, such as 

fade, equalizer, doppler, mechanize, echo, reverse, time warp, noise reduction, pop/click filtering, and more. 

It is perfect for voice-over or dictation work, editing music for dance programs, creating podcasts, restoring 

audio from old vinyl records, or just having fun. New files can be recorded from a cassette deck, turntable, 

radio, microphone, etc. or digitally copied from an audio CD. Real-time visuals are displayed during 

playback and recording. See audio in ways you've never seen it before. GoldWave supports MP3, OGG, 

WAV, WMA, and many more audio formats and performs batch conversions and processing. Version 5.16 

added track information and preview to CD Reader; added Previous marker command. Added partial dual 

core processor support. Added new keyboard shortcuts.” (http://www.download.com/GoldWave/3000-2170_4-

10601215.html?tag=lst-0-1)  

 

**) “Audacity is a free, easy-to-use audio editor and recorder for Windows, Mac OS X, GNU/Linux, and other 

operating systems. You can use Audacity to:  record live audio, convert tapes and records into digital 

recordings or CDs, edit Ogg, Vorbis, MP3, and WAV sound files, cut, copy, splice, and mix sounds together, 

and change the speed or pitch of a recording.” (http://audacity.sourceforge.net/about/) 
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Basic steps in music video productions* 
 

 

Song  
 

 

 

 Extract  
 

 

 
 Save 
 

 

 

  Find Images 

 

 
 

  Production 

   
 

 Editing 

 

 Presentation 

 

______________________ 

*) All movie-making software comes with a HELP tab on top of the screen. There are also on-line 

manuals and tutorials that will show you step-by-step how to use the software. 

Pinnacle Studio: http://www.pinnaclesys.com/PublicSite/us/PinnacleLife/Content/Tutorials/ 

iMovie: http://manuals.info.apple.com/en/iMovie_08_Getting_Started.pdf 

Windows Movie Maker: http://www.microsoft.com/windowsxp/using/moviemaker/default.mspx  

 

Choose a song with potential 

imagery 

Extract song from CD using 

GoldWave, or download it from 

www.altavista.de or from i-Tunes 

Save song as MP3 or WAV file  

Use a search engine to find 

the needed images 

Insert songs and images into a film 

editing software, iMovie or Movie Maker 

Add transitions, subtitles, special 

effects, animation, credits, titles, 

cut out undesirable parts or add 

voice over, etc. 
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Four steps in digital filmmaking 

 
 

1. Capture it  
 

 

 2. Edit it   
 

 

 3. Make it  
  

 

  4. Show it  
 
 

1. Capture the scenes from a digital camera or a video recorder, or download images and 

films from the Internet 

 

2. Edit the images, captured scenes and arrange them in the order you want. Add 

transitions, video and sound effects, voice over, background music, images, titles, 

chapter markers, etc. 

 

3. Choose the finished movie format you want your film to be:  

• DV Tape to transfer the film to a a DV or VHS tape, or to watch it on TV 

• Burn it on DVD 

• Save it as an AVI-film (Audio Video Interleaved: a preset high resolution standard 

format) 

• Multimedia MPEG-Format (*.MPG): de-facto format for video on the Web or to play on 

your PC with various setting options for resolutions and file sizes 

• Post it on the web as a streaming video: Real Video (*.RM), Windows Media 

(*.WMV), or Apple’s QuickTime Movie (*.MP4 or *.MOV) 

•  Upload it to a website for sharing with others. 

 

4. Show your film using a VCR or a computer with an LCD Projector. 
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Create Your Own Music Video 
 

I. Collecting data: images and sounds 

1. Choose a song with potential imagery 

2. On your hard drive, create a folder with name of song, i.e. “In the Ghetto” and inside this 

folder create two sub folders: “Ghetto Images” and “Ghetto Music.” 

3. Use a language specific search engine (i.e. google.fr or google.de) to find images. Make sure 

that you choose images with high resolution (at least 800 pixels). The Google search engine 

allows you to sort the images according to size. 

 

4. Download image by right clicking on it and saving it onto your hard drive, in the same folder 

you have created for the song, i.e. “In the Ghetto.” Name the image in a way so that you can 

easily find it. Use the words from the songs and number them starting with 001, i.e. “001 

Ghetto” or “001 Chicago.”  

5. Create a “Works Cited” page for all images.  

6. Find the lyrics online. Many music bands offer the lyrics to their songs free of charge. 

However, sometimes it is complicated to find them. There are many on-line sites listing the 

lyrics of many songs. I would recommend one of the following: 

• http://www.ingeb.org/index.html (best website 

with more than 20,000 songs 

• http://wwwmetrolyrics.com 

• http://www.mp3lyrics.org 

• http://lyrics.dreamnicky.com/ or http://www.chinese-tools.com/songs (Chinese songs) 

• http://www.paroles.net/ or http://www.paroles-musique.com (French songs) 

• http://www.donquijote.org/spanishlanguage/lyrics/ (Spanish songs) 

• http://www.golyr.de/  or http://www.lyrics.de/ (German songs) 

7. Extract song from CD using iTunes, GoldWave, or find it and download it from the Internet, 

e.g. from www.altavista.de or from i-Tunes 

8. Save song as MP3 or WAV file in the folder you have created. 
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II. Windows Movie Maker – Interface 
 

Timeline View 

 

 

Storyboard View 
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Create a new Project 

 
1. Open Windows Movie Maker and then click on File > New Project > Give your project the same 

name as your song, i.e. “In the Ghetto” and save it in the same folder you have created with all 

downloaded images and the music. On the left in the Movie Tasks Pane, there are three Movie 

Tasks: Capture Video, Edit Movie and Finish Movie. Next to it, in the Collection Pane, you’ll 

see either nothing or images from your previous project. 

 

 
 

2. On the right is the Monitor or the Preview Screen. In the bottom left are the Playback button 

and on the right are the icons for Slice (slicing images or videos in two) and the button for Take 

a Still Image from a video. 

 
 

Playback 

Slice/ Take Image 
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3. Below the Movie Task Pane you’ll find various tracks, depending on whether you are using the 

Storyboard View or the Timeline View.  

Storyboard View is a scene-by-scene view. Use this view when you add images and transitions 

or image effects. The images that you see in the Storyboard show are the first frame of the clip 

(in case you are using a video) or the entire image you are using. Each image you add is 

automatically set at 5 seconds long. The transition between images is 1.25 seconds. If you want 

to make the images longer or shorter, then use the Timeline view. You can add transitions by 

dragging them into the gap between the various clips. 

 

 

Timeline View allows you to see the time and duration of each clip you add (video, image or 

audio), but also the titles. It is a more complex approach but it offers you many more options 

than the Storyboard view. The movie you are making is shown in real time as it is built with 3 

tracks: Video, Audio/music, and Title Overlay. Above the video track, you will see the time in 

seconds. You can zoom in and zoom out in the Timeline View. Just click on  (zoom in) or  

(zoom out) above the word Video.  Next to this you can play your video, rewind or add a voice 

over using a microphone. 

 

 

 

 

 

 

Below the Title Overlay track you will see a blue slider. This will allow you to move forward or 

backwards in the film. It is the same function like the one in the Monitor. The Play Head is the 

blue line with a blue square on the top. This is your movie cursor. You can drag it to the right or 

left to get to the place where you want to add anything you want. Click on the blue box and then 

drag to the right or left. 

Play Head Playback 
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Create Your Own Music Video: 6 Steps 

 
 

1. Create Project  
 

 

 

 2. Add Music 
 

 

 

 3. Add Pictures   
 

 

 

 4. Add Subtitles  
 

 

 

5. Add Transitions 

and Video  Effects  
 

 

 6. Sync It  
 

 

 

 7. Make It 
 

 

There are seven basic and simple steps that you must follow to make a music video. In case you 

want to know more, then check out the HELP tab in the Menu Bar of Windows Movie Maker. 

Here are the steps: 

1. Create new project and Save Project  

2. Import your song 

3. Import the pictures (and or video) 

4. Add titles and subtitles (if you 

want to do that) 

5. Add transitions and image effects 

6. Sync your images, titles and music 

7. Make or finish your video 
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Step 1: Create New Project:  
Your first step after opening Window Movie Maker or any other software is to create a file 

for your music video project. Click on FILE > then choose NEW PROJECT from the drop 

down list. Save your new project by clicking on FILE again and on SAVE PROJECT AS 

from the drop down list. Give your project the name of the song, i.e. “In the Ghetto”.  

 
 

Step 2: Import song:  
In the Movie Task Pane on the left, click on Import Audio or Music and find the song 

you have already extracted from the CD or you have downloaded from iTunes, then click 

Import. The song will then appear in the Collection Pane.  

 

 

IMPORTANT: Save your project very often! 
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Now it is the time to add your song to the project. Make sure you are in the Timeline View. 

Drag and drop the song into the Audio/ Music Track.  

 

 

 

Step 3: Import Pictures:  
In the Movie Task Pane on the left, click on Import Pictures. Locate the images in the 

folder you have created. To do so, you must change the default pictures folder (it is either 

the My Pictures or the My Videos) by clicking on the folder icon next to the window for My 

Pictures. 

After opening the folder with the images you have downloaded from the Internet or you 

have taken yourself, just highlight the first image by clicking on it once, then drag the blue 

bar below the list of images to the far right and then hold down the SHIFT tab and click on 

the last image once. This will highlight all images. Click IMPORT. All images will then be 

imported into the Collection Pane alongside the song you have already imported.  

 

   
 

To add the images to the project, switch to the Storyboard View. Drag and drop the 

pictures hat fit with the song into the empty boxes in the storyboard track.  

 

IMPORTANT: Save your project! 
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A populated Storyboard track will look like this one: 

 

A populated Timeline View track will look like this one: 

 

The default size of all images is 5 seconds with a transition of 1.25 seconds. To change that, 

click on Tools > Options > Advanced. Here you can change the length of the image, the 

transitions between images, and more. However, I would not play with this until you are 

comfortable using Windows Movie Maker. 

   

Changing the length of images in the Timeline View:  

To change the length of the images to fit the sound track, you must be in the Timeline 

View. Use Zoom In to enlarge the images to 5 seconds per image.  Highlight the image you 

want to shorten or lengthen by clicking on it once. Move the curser (mouse) almost to the 

right end of the image and you’ll see that there is a red two-headed arrow and a text box 

that says: “Click and drag to trim image”. Here is what you need to do: Drag the cursor to 

the right to lengthen the image or to the left to shorten it. You need to play the song very 

often to find out whether the images fit the music.  

 

IMPORTANT: Save your project! 
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Step 4: Add text and titles:  
There are two kinds of titles that you can add to the movie: Full Screen Titles that will 

be used as images before or after certain frames or images and Overlay Titles, these are 

titles that will be displayed on top of the images or film frames. I use the first kind for 

subtitles and the second one for opening and end credits.  

To add a title, click on Make Title or Credits in the Edit Movie part of the Movie Task 

Pane. You will be give 5 options. They are: 

 

 
 

To add titles and credits to the film, you must be in the Timeline View. To add a title (or 

series of titles) at the beginning of the movie, move the cursor (play head) to the far left, to 

the beginning of the Timeline View track.  Click on the “Make Titles or Credits”. Click on 

“Add title at the beginning of the movie”. In Enter Text for Title box type the title of your 

video, e.g. “In the Ghetto” (upper box) “by Elvis Presley” (lower box).  

 

IMPORTANT: Save your project! 
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How to change the font and color of the text:  

Scroll down using the blue bar on the right hand side and choose Change the text and 

font color The Select Title Font and Color page appears. Select this option to change 

the font (Font style, color, size, and alignment.) 

 

 

 

 

 

IMPORTANT: Save your project! 
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How to change the Title Animation 

 
Click on Change the title animation (it is below Edit title text under More options) 

see previous image. Select the animation option for the title. There are 3 animation 

options: Titles, One Line; Titles, Two Lines; and Credits. Select the animation option 

you like. For the title of my song, I chose from the Titles, Two Lines the Fade, In and 

Out animation. 

 

 
 

After you are finished with editing the text and the animation, just click Done to add the 

title to the film. Your title(s) will appear at the beginning of the film 

 

 
 

 
 

 

 

 

IMPORTANT: Save your project! 
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Adding Subtitles to the images in the target language 

 
To add subtitles and credits to the film, you must be in the Timeline View. To add 

subtitles in the target language, first you must highlight the image you want to add 

subtitles to. First move your play head (cursor) to the place where the text should appear. 

And then follow the steps described above for adding titles. This time choose the “Add 

titles on the selected clip on the storyboard”. (See image 1 above on page 13.) In the 

new window type the text in the Enter Text for Title box. Follow directions above to 

change text and font color and the title animation.  
 

 
 

For the Title Animation, I would always choose from Titles, One Line the Subtitle 

(Subtitle at bottom (overlay)) animation. See next image. 
 

 
 

IMPORTANT: Save your project! 
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Here is what the titles and subtitles would look like in the Timeline View: 

 

 
 

Once you have added all images and subtitles, now you can add transitions between the 

images and if you like also video effects to your images.  

 

Step 5: Add transitions and image effects: 
 You can add transitions between the frames or the images. This will make the transition 

from one image to the other smoother, and it will look more professional.  

 To add transitions, you should be in the Storyboard View. Click then on View Video 

Transitions in the Edit Movie part of the Movie Task pane.  

 

There are various kinds of transitions (from Bars to Spin to Zig Zag). Windows Movie 

Maker comes with a limited number of transitions. However, these are enough for our 

purposes. I use only standard transitions, e.g. Fade and Dissolve, and some times Eye or 

Circle.  

To add a transition just drag and drop the transition you like between the images or 

frames. The length of the transitions is preset.  

 

 

 

IMPORTANT: Save your project! 
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To add a video effect to the images, use the Storyboard View. Click on the image that you 

want to animate. You will see that there is a faded star in the left bottom corner of the 

image. That means that this image is not animated. There has been no effect added to it. 

To add a Video Effect, click on the View Video Effects in the Edit Movie part of the 

Movie Tasks Pane. A collection of various effects will appear. They range from Blur to 

Posterize to Watercolor. Drag the video effect you like and drop it on top of the star on 

the image. You can double click on the effect to see what it looks like.  

 

 
 

To remove a Video effect, simply right click on the image and then choose Cut. The effect 

will disappear. DON’T choose DELETE. Otherwise you’ll delete the entire image. 

 

Step 6: Sync images with titles and music:  
Once you are done with everything, you must synchronize images with music and titles. 

This can take a while the first time, but once you have done it a few times, it is easy to do. I 

would not recommend too many animations, or fancy transitions, unless you want to draw 

attention to a specific part of the image or you want to highlight part of that image.  

 

After you are satisfied with the outcome, save your project under a new name like “In the 

Ghetto with Subtitles”. Now it is time to finish and make your film. Don’t forget, what 

you have created so far is only a Windows Movie Maker project (In the Ghetto.MSWMM).  

 

Step 7: Finish (make) your film:  
Before you finish and make the film, you should preview your project. To preview your 

project, move the film cursor above the play button on the Monitor (Preview Screen) on the 

top right-hand side all the way to the left and then hit play. After you have previewed and 

synchronized your project, you are ready to finish (make) your movie. In the Movie Tasks 

Pane under number 3. Finish Movie, you’ll see the following 5 options: 

• Save to my Computer (recommended); 

• Save on CD 

• Send in email; 

• Send to the Web, 

• Send to DV camera.  
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Save to my computer is the option you want to choose when you want to create a film 

that will be uploaded to the web (to YouTube or TeacherTube). Click on the Save to my 

computer link. You will get the following image: 

 

 
 

Choose the folder you have created for the film to save the finished film in. The default 

folder is My Videos. Click on Browse and find the folder you have created, in my case “In 

the Ghetto”. Click Next. Here is what the image will look like: 
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The next window will give you the settings for your movie (image size and quality). You can 

either select the Best quality for play back on my computer (recommended) or Best 

fit to file size (tells you the size in MB) or you can select Other settings. If you choose 

the Other settings option, select High quality video (NTSC).  

 

 
 

You should experiment with various formats to see the difference. Beginners should stick 

with option 1, the default and recommended setting: “Best quality for playback on my 

computer”. Click Next. Here is what it looks like: 
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The size of my “In the Ghetto” project (almost 3 minutes long) would be 44 MB. The 

Saving Movie page appears showing the time remaining. Our project would take almost 3 

minutes to make into a film. Once completed, click Finish and the film will automatically 

play in the Windows Media Player. The finished product is a .wmv file and the final size 

is 20% smaller than originally was calculated (35 MB instead of 44 MB).  

 

Save a Movie to a CD-ROM (use this option for longer projects, 10 minutes plus) and for 

high quality recordings). 

1. From the Finish Movie Task pane choose Save to CD or from the File Menu, select 

Save Movie File. 

2. Insert a recordable CD in the CD-ROM drive. 

3. On the Save Movie Wizard page, select recordable CD and click Next. 

4. Type a name for your film in Enter a name for your saved movie. 

5. Type a name for the CD in Enter a name for the CD and click Next. 

6. On the Movie Setting, select Best fit for recordable CD (recommended). Click Next. 

7. The Saving Movie page appears showing the time remaining. Once completed, click 

Finish. The CD will be ejected automatically. If not, then press eject button on the 

recordable CD drive. 

 

After you are finished making your film in the format you like, open your project again and 

delete all subtitles from the Title Overlay track by clicking on the first title and dragging 

the blue bar below that to the end and clicking on Shift and the last title at the same time. 

This way you will highlight all subtitles. Click Edit in the Menu Bar and then Delete. All 

subtitles will be deleted. Save your project under a new name by clicking on File in the 

Menu Bar, then on Save Project As and give the new project the name “In the Ghetto 

Without Subtitles”. Now follow the same steps above to make a new movie of your video 

without subtitles. Make sure to give the film a different name, e.g. “In the Ghetto Without 

Subtitles”. This way you have two projects, one with and the other without subtitles. I 

usually show the one without subtitles first and will show the version with subtitles at the 

very, very end of class to make sure the students understood everything.  

Hurray! My music video is done. 
Good Luck and HAVE FUN! 
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CONCLUSIONS 
 

The following are some reflections on the use of self-produced videos in the foreign language 

classroom: 

 Creativity: Teachers and students can be creative and use their own imagination. 

 Motivation and a boost for self-confidence: This is a highly motivational method, especially 

for linguistically weak and unmotivated, or shy and quiet students.  

 Articulation and self-expression: Film is art and a way to articulate and express yourself. 

 Practice: Students can practice what they have learned so far. This enhances their listening, 

writing, speaking and reading skills. 

 Freedom of choice: The students can choose their own songs and in this way they can 

concentrate on their own interests. 

 Repetition and application of grammar structures, vocabulary, proverbs and idioms -- almost 

everything they studied in class. Students will have to understand the song correctly to be able 

to create a cohesive music video. They will have to read the lyrics and understand them. 

 Alternative method of assessment. Students are not under stress. They can take their time to 

create the music video. They gain self-confidence. They use their language skills without fear 

and inhibition. 

 Multi sensory learning environment with a gradual skill development technique 

 This method contributes to the enhancement of cooperative learning and group dynamics, 

in case two or more students work on a single project. 

 What they produce is unforgettable and can change their lives. One good example is Michael, a 

former student of mine, who dubbed one part of Star Wars into German. He came to the college 

to be a Business Major and eventually to take over his mom’s business after graduation. After 

his video project, he decided to become a communications major with a concentration in 

filmmaking. For his senior project, he produced a 60-minute feature film. 

 Filmmaking is a good educational experience for students with different learning styles: 

 The “readers” and “writers” can research the topic and write the script. 

 The “hands-on learners” can operate equipment and create sets. 

 The “oral expressers” can be performers. 

 “Kosher”: The music videos can be used as a tool to recruit other students. It is legal (your own 

production) and above all “kosher,” with no profanity, nudity, etc. They are rated “PG13”  and 

not “R”  

 Students gain a sense of an “overall sense of accomplishment” and success. 

 Students learn a new technical skill that might be beneficial in the future. 

 Finally and above all, it is fun. It is an “enjoyable experience.”  Film production is not dry. 

It is never boring. It is easy to implement and instills student confidence. 


